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Chapter 542

GEE Tests for Two
Proportions in a SplitMouth Design
Introduction
This procedure assumes that binary data will be obtained from a study that uses a split-mouth design. The GEE
method is used to analyze the repeated measures model that is assumed. The sample size formula is derived in
Zhu, Zhang, and Ahn (2017).
A split-mouth design is used in dental trials in which treatments are randomized over segments of the mouth
within each subject. In this design, the mouth is divided into two or more segments or regions. For example, the
segments might be top and bottom, left and right, or a combination of both. Within each segment, specific sites
(e.g. teeth) are identified. The same treatment is applied to all sites within a segment.
The split-mouth design, also called the split-cluster design, is occasionally used in other areas such as
dermatology and animal studies. Although the design may be used in other experiments, the terminology of the
split-mouth design will be used in this procedure.

Technical Details
Our formulation comes from Zhu, Zhang, and Ahn (2017). The goal of this analysis will be to provide a test
comparing the response proportions of two groups. We assume that the two groups are labelled “1” for treatment
and “2” for control.
Denote an observation by 𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 where i = 1, 2 gives the group, j = 1, 2, …, N gives the subject, and k = 1, 2, …, M
gives the site. A “success” is represented by 𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 = 1 and a “failure” by 𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 = 0. Note that the segments
themselves are not specified directly in the model. Also note that the total number of sites per subject is 2M.
The following logistic regression model will be analyzed using GEE.
logit�Pr�𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 = 1�� = 𝑙𝑙𝑙𝑙𝑙𝑙 �

𝑝𝑝𝑖𝑖𝑖𝑖𝑖𝑖
� = 𝛽𝛽0 + 𝛽𝛽1 𝑥𝑥𝑖𝑖𝑖𝑖 + 𝜖𝜖𝑖𝑖𝑖𝑖𝑖𝑖
1 − 𝑝𝑝𝑖𝑖𝑖𝑖𝑖𝑖

where 𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 follows a Bernoulli distribution with parameter 𝑝𝑝𝑖𝑖𝑖𝑖𝑖𝑖 , 𝛽𝛽0 is the log-transformed odds for group 2 (control
group), 𝛽𝛽1 is the log-transformed odds ratio between the treatment and control groups, 𝑥𝑥𝑖𝑖𝑖𝑖 = 1 if the site is in group
1 and 𝑥𝑥𝑖𝑖𝑖𝑖 = 0 if the site is in group 2, and 𝜖𝜖𝑖𝑖𝑖𝑖𝑖𝑖 is random error.

Two alternative models are available to model the correlation between 𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 and 𝑌𝑌𝑖𝑖′𝑗𝑗𝑗𝑗′ (responses within the same
subject). The simpler model assumes that a common, within-subject, correlation 𝜌𝜌 is at work. A more general
model assumes that there are two, within-subject, correlations. These are 𝜌𝜌𝑊𝑊 , which is the correlation between
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responses of sites within the same segment, and 𝜌𝜌𝐵𝐵 , which is the correlation between responses of sites that are
not in the same segment.
Zhu, Zhang, and Ahn (2017) provide formulas for the overall sample size for a two-sided test as follows
𝑁𝑁 =

where
𝜎𝜎 2 =

𝑃𝑃1 =

𝑃𝑃2 =

2

𝜎𝜎 2 �𝑧𝑧1−𝛼𝛼 + 𝑧𝑧1−𝛽𝛽 �
2

𝛽𝛽12

{1 + (𝑀𝑀 − 1)𝜌𝜌𝑊𝑊 }(𝑃𝑃1 𝑄𝑄1 + 𝑃𝑃2 𝑄𝑄2 ) − 2𝑀𝑀𝜌𝜌𝐵𝐵 �𝑃𝑃1 𝑄𝑄1 𝑃𝑃2 𝑄𝑄2
𝑀𝑀𝑃𝑃1 𝑄𝑄1 𝑃𝑃2 𝑄𝑄2

exp(𝛽𝛽0 + 𝛽𝛽1 )
1 + exp(𝛽𝛽0 + 𝛽𝛽1 )
exp(𝛽𝛽0 )
1 + exp(𝛽𝛽0 )

𝑄𝑄1 = 1 − 𝑃𝑃1

𝑄𝑄2 = 1 − 𝑃𝑃2

P1 /Q1
�
𝛽𝛽1 = log �
𝑃𝑃2 /𝑄𝑄2

and 𝛼𝛼 is the probability of a type-I error and 𝛽𝛽 is the probability of a type-II error.

𝑃𝑃1 and 𝑃𝑃2 are the true success rates of groups 1 (treatment) and 2 (control). These are the values assumed by the
alternative hypothesis at which the power is calculated

These results are for the general two, within-subject correlations. The sample size for the one correlation method
is obtained by setting 𝜌𝜌 = 𝜌𝜌𝑊𝑊 = 𝜌𝜌𝐵𝐵 .

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power, Sample Size, or Effect Size.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Note that this procedure assumes a two-sided test.
Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard.
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha
that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Subjects)
Enter one or more values for N, the number of subjects in the study. If you enter a list of values, a separate
analysis is done for each value.
Range
N>1
Examples: 10 20 30 40 or 20 to 200 by 20.
M (Sites Per Group Per Subject)
Enter one or more values of the number of sites (e.g. teeth) per group per subject. The design is balanced so that
M is the number of sites in all segments assigned to the treatment group and also M is the number of sites in all
segments assigned to the control group.
The split-mouth design assumes that the mouth is subdivided into two or more segments (e.g. left and right, top
and bottom, etc.), each made up of a number of sites. The two treatments are randomly assigned to segments in
such a way that both groups include M sites.
Range
This value must be a positive integer that is at least 2.
List
You can use a list of values such as "4 6 8". A separate analysis will be run for each element in the list.
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Effect Size
P1 Input Type
Indicate what type of values to enter to specify P1, the group 1 event probability. Regardless of the entry type
chosen, the same test statistic is used in the power and sample size calculations. This option is simply given for
convenience in specifying the P1.
The choices are
•

P1
Enter values for P1 directly.

•

Difference (P1 - P2)
Enter values for the difference (P1 - P2) and values for P2. The corresponding value of P1 will be computed
from these two values.

•

Ratio (P1 / P2)
Enter values for the ratio (P1 / P2) and values for P2. The corresponding value of P1 will be computed from
these two values.

•

Odds Ratio (O1 / O2)
Enter values for the odds ratio (O1 / O2) and values for P2. The corresponding value of P1 will be computed
from these two values.
Note that O1 = P1/(1-P1) and O2 = P2/(1-P2)

P1 (Group 1 Proportion)
Enter a value for the response proportion of group 1 (the experimental or treatment group) under the alternative
hypothesis, H1. The power calculations assume that this is the actual value of the proportion.
Values must be between 0 and 1. This value must be different from P2.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.
P2 (Group 2 Proportion)
Enter a value for the response proportion of group 2 (the control, baseline, standard, or reference group).
Values must be between 0 and 1. This value must be different from P1.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.
Difference (P1 - P2)
Enter the difference between P1 and P2. This difference is used with P2 to calculate the value of P1 using the
formula: P1 = Diff+ P2.
You can enter a single value such as 0.05 or a series of values such as 0.03 0.05 0.10 or 0.01 to 0.09 by 0.02.
Range
Differences must be between -1 and 1. They cannot take on the values -1, 0, or 1. The resulting value of P1 must
be between 0 and 1. If it is not, the scenario is skipped.
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Ratio (P1 / P2)
Enter the ratio of the two probabilities P1 and P2. This ratio is used with P2 to calculate the value of P1 using the
formula: P1 = Ratio x P2.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 0.25 to 2.0 by 0.25.
Range
Ratios must be greater than zero. They cannot take on the value of one. The resulting value of P1 must be between
0 and 1. If it is not, it is changed so that it is between 0 and 1.
Odds Ratio (O1 / O2)
This option specifies the odds ratio between the two probabilities P1 and P2. This value is used with P2 to
calculate the value of P1.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.
Range
Odds ratios must be greater than zero. They cannot take on the value of one.
Correlation Matrix Structure
Specify the structure of the correlation matrix of sites within a subject. The possible choices are
•

One Within-Subject Correlation (ρ)
A common correlation is assumed for all outcome pairs within the same subject.

•

Two Within-Subject Correlations (ρв, ρᴡ)
Two within-subject correlations are needed:
ρв is the correlation between sites in different segments within a subject.
ρᴡ is the correlation between sites within a particular segment within a subject.

ρ (Within-Subject Correlation)
Enter one or more values for ρ, the common correlation of site outcomes within the same subject. At least one
value must be entered. If multiple values are entered, a separate analysis is performed for each value.
Range
-1 < ρ < 1. A value near 0 indicates low correlation. A value near 1 indicates high correlation.
Note that negative values may cause numerical trouble and should be avoided.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 or 0 to 0.8 by 0.1.
ρв (Between-Segment Correlation)
Enter one or more values for ρв, the correlation of site outcomes that are in different segments within a subject. At
least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.
Range
-1 < ρ < 1. A value near 0 indicates low correlation. A value near 1 indicates high correlation.
Note that negative values may cause numerical trouble and should be avoided.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 or 0 to 0.8 by 0.1.
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ρᴡ (Within-Segment Correlation)
Enter one or more values for ρᴡ, the correlation of site outcomes that are in the same segments within a subject.
At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.
Range
-1 < ρ < 1. A value near 0 indicates low correlation. A value near 1 indicates high correlation.
Note that negative values may cause numerical trouble and should be avoided.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 or 0 to 0.8 by 0.1.
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Example 1 – Calculating Sample Size
Suppose a dental clinical trial is being planned in which the mouth is divided into four segments with three sites
in each. The trial is being conducted to compare a new treatment for gingivitis with a common existing treatment.
In the study, suppose P1 = 0.6, 0.65, 0.7; P2 = 0.5; ρB = 0.2, 0.4, 0.6, 0.8; ρW = 0.8; M = 5; alpha = 0.05; and
power = 0.9. Sample size is to be calculated for a two-sided test.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha (Two-Sided Test) .......................... 0.05
M (Sites Per Group Per Subject) ............ 5
P1 Input Type ......................................... P1
P1 (Group 1 Proportion) ......................... 0.6 0.65 0.7
P2 (Group 2 Proportion) ......................... 0.5
Correlation Matrix Structure .................... Two Within-Subject Correlations (ρв, ρᴡ)
ρв (Between-Segment Correlation) ........ 0.2 0.4 0.6 0.8
ρᴡ (Within-Segment Correlation) ........... 0.8

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────

Power
0.9008
0.9004
0.9015
0.9005
0.9012
0.9017
0.9030
0.9164
0.9028
0.9019
0.9082
0.9222

Total
Sample
Size
N
335
230
126
21
148
102
56
10
83
57
32
6

Sites
Per
Group
Per
Subject
M
5
5
5
5
5
5
5
5
5
5
5
5

P1
0.6000
0.6000
0.6000
0.6000
0.6500
0.6500
0.6500
0.6500
0.7000
0.7000
0.7000
0.7000

P2
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000

Between Within
Segment Segment
P1-P2
Corr
Corr
Diff
ρв
ρᴡ
0.1000 0.2000 0.8000
0.1000 0.4000 0.8000
0.1000 0.6000 0.8000
0.1000 0.8000 0.8000
0.1500 0.2000 0.8000
0.1500 0.4000 0.8000
0.1500 0.6000 0.8000
0.1500 0.8000 0.8000
0.2000 0.2000 0.8000
0.2000 0.4000 0.8000
0.2000 0.6000 0.8000
0.2000 0.8000 0.8000

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Zhu, H., Zhang, S., Ahn, C. 2017. 'Sample size considerations for split-mouth design'. Statistical Methods in
Medical Research. Volume 26(6). Pages 2543-2551.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
Total Sample Size N is the total number of subjects in the study.
Sites Per Group Per Subject M is the number of sites per subject in the treatment group and the control group.
P1 is the proportion of "true" responses in group 1 (treatment group).
P2 is the proportion of "true" responses in group 2 (control group).
Between Segment Corr ρв is the correlation between sites in different segments within a subject.
Within Segment Corr ρᴡ is the correlation between sites within a segment within a subject.
Alpha is the significance level of the test: the probability of rejecting the null hypothesis of equal means when it is
true.
Summary Statements ─────────────────────────────────────────────────────────
A split-mouth (split-cluster) design is used to test the difference between two response proportions. The logistic
regression model will be analyzed using GEE. A sample of 335 subjects with 5 sites per group per subject
achieves 90% power at a significance level of 0.050 to detect a difference of 0.1000. The response proportion of
group 1 is 0.6000 and of group 2 is 0.5000. The correlation matrix is formed using a correlation of 0.8000 for sites
within the same segment and a correlation of 0.2000 for sites from different segments.

This report gives the sample size for each of the scenarios.

Plots Section

These plots show the sample size for the various combination of the other parameters.
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Example 2 – Finding Sample Size and Validation using Zhu,
Zhang, and Ahn (2017)
Zhu, Zhang, and Ahn (2017) page 2549 provide a table (Table 2) in which several sample size values are
presented. We will use the first entry from this table to validate this procedure.
In the first row of Table 2, P1 = 0.15; P2 = 0.1; ρв = 0.05; ρᴡ = 0.1; M = 3; alpha = 0.05; and power = 0.8. The
resulting N is 244.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.8
Alpha (Two-Sided Test) .......................... 0.05
M (Sites Per Group Per Subject) ............ 3
P1 Input Type ......................................... P1
P1 (Group 1 Proportion) ......................... 0.15
P2 (Group 2 Proportion) ......................... 0.1
Correlation Matrix Structure .................... Two Within-Subject Correlations (ρв, ρᴡ)
ρв (Between-Segment Correlation) ........ 0.05
ρᴡ (Within-Segment Correlation) ........... 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────

Total
Sample
Size
Power
N
0.8003
244

Sites
Per
Group
Per
Subject
M
3

P1
P2
0.1500 0.1000

P1-P2
Diff
0.0500

Between
Segment
Corr
ρв
0.0500

Within
Segment
Corr
ρᴡ
0.1000

Alpha
0.050

PASS matches the sample size of 244.
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